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Introduction
When writing questions for the ABP, it is always 
better to include an image rather than a pure text 
question. Images form the basis of the practical 
exams. Getting good images can be difficult and 
sometimes you may have a great idea for a ques-
tion but just don’t have access to a glass slide to 
photograph. The purpose of this paper is to cover 
ways to safely appropriate images from the web.

There are two methods discussed. The first uses 
whole slide image repositories to find a virtual 
glass slide that can then be used to take a screen 
shot of region of interest. The second is to search 
the web for static images that are either in the 
public domain or have usage rights that only re-
quire attribution.

Suggestions and improvements to this document 
are always welcome.
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Executive Summary
There are two ways to get images from the web to use in ABPath questions. 

Option 1: Whole Slide Images
There are many websites that contain virtual slide pathology files. One of the easi-
est to use is PathPresenter.net. Here are the steps:

1. 	Log in (free account)
2. 	Click on Slide Library
3. 	Perform a search
4. 	Manipulate the whole slide image to find a region of interest
5. 	Click on the Camera icon to save the field of view to the desktop

Option 2: Google (or Bing) Image Search
The web has millions of pathology images but many are copyright protected. 
Google and Bing allow you to display only images that are either in the public do-
main or can be used without royalties (ie., free use). In the latter instance, attribu-
tion may have to be given. The instructions below are for Google.

1. 	Do an image search
2. 	Click on the Tools button
3. 	Click on the Usage Rights drop down menu
4. 	Select Labeled for Reuse with modification
5. 	Click on an image from the filtered list to enlarge it and show image info
6.	 Drag the image to the desktop to save it
7. 	Go to the image website and get the attribution requirements (if any)
8.	 If attribution is required, add it to the references field in the item bank

Note: In most instances, the images will be from WikiMedia/WikiCommons, 
Fickr, or other image-sharing site. WikiCommons will list the specific attribu-
tion required. A typical example would be: Copyright ©Jack Jones /  CC-BY-
SA-3.0

Resize and/or Reformat the Image
Data Harbor requires images be in jpeg format and no larger than 1500 x 1500 
pixels. A resolution of 72 ppi (or slightly higher, up to 180 ppi) is best. Use the 
Preview app on the Macintosh or Paint on a Windows PC to change the format to 
jpeg, if needed and to adjust the image size.
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Part 1: Using Whole Slide Image Repositories
An excellent option for creating images is to use any of the whole slide image 
repositories on the web. 

In this scenario, a virtual slide displaying the requisite diagnostic features is used 
for a screen capture. Some of the whole slide image viewers have image capture 
built in but if not, a simple screen shot of the area of interest will be almost as 
good.

PathPresenter is one such site and the following pages walk you through the 
procedure for finding a suitable virtual slide, zooming into an area of interest, 
and then grabbing a screen shot. Several other whole slide image repositories are 
listed at the end of this section. 

Please keep in mind that not all these sites have been curated by experts, so some 
diagnoses may be erroneous. This was noted by one of the MOC TDAC members 
(Matt Kuhar) who found several incorrect diagnoses when searching the reposito-
ry for a dermpath image.

One advantage of using a virtual slide as the basis for capturing a field of interest 
is that there are no copyright issues to contend with. The whole slide image files 
themselves may be subject to licensing but zooming into an area of interest and 
capturing a static image is analogous to taking a photomicrograph of a glass 
slide. Attribution is not required.
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Go to PathPresenter.net
Create a free account if this is the first 
time you are accessing the site.

Click and hold the 
mouse button to 
move around the 
image. Zoom in and 
out with the scroll 
wheel or use the 
navigation bar. 

Scroll to an image you want to capture. Click 
the Info Icon to see details of the case. Click the 
Display button to open the whole slide image.

Find a region of interest and capture it using 
your computer’s built in screen capture soft-
ware or click on the camera icon which will save 
the current view to your desktop.

captured image

Toggle the tracker 
thumbnail on and off

select an organ system

Camera tool

image tracker 
thumbnail

Click on Slide Library to search 
for a whole slide image.

1. Capture Images from PathPresenter
This site was developed by Rajendra Singh, Associate Director of Dermatopa-
thology at Mt. Sinai School of Medicine in New York City. It contains thousands of 
whole slide images from many organ systems. Most are of excellent quality al-
though some diagnoses may be erroneous. Raj and his team are slowly fixing this.
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2. Other Whole Slide Image Repositories
Besides PathPresenter, there are a number of very good whole slide image re-
positories on the web. Some are behind academic firewalls but others are freely 
accessible.  A good starting point is found on the Digital Pathology Association’s 
website: 

https://digitalpathologyassociation.org/whole-slide-imaging-repository

Note that creating static images from whole slide images does not require attribu-
tion because of the derivative nature of the process— it is similar to photomicros-
copy of a glass slide. Attribution is only needed if a link to the whole slide image is 
used by the ABP.

http://www.rosaicollection.org https://proscia.com/explore

https://www.best.edu.au/s/featured http://www.virtualpathology.leeds.ac.uk
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Part 2: Searching for Static Web Images

Introduction
Finding images on the web is not a problem but filtering those images so that 
only specific ones are displayed requires advanced search techniques. This section 
of the document discusses how to find an image that is free to use without copy-
right restrictions and how to properly attribute it (if required).

Image search can be done using Google or Bing but this document will focus 
primarily on a Google search.

Advanced Search Criteria
When you do a Google Search, you can filter your results to find images, videos, or 
text that you have permission to use. This is done with an Advanced Search filter 
called “usage rights” that lets you know when you can use, share, or modify some-
thing you find Online. 

Until a few years ago, the Advanced Search filter (found under the Settings but-
ton) was the only way to apply specific search criteria to a set of images, such as 
size, color, type and—most importantly for this discussion—usage rights. Google 
added a shortcut so that it is easier to apply usage rights search criteria. This is 
discussed on page 10.

Search Tips
Most people just type in a few search words to initiate a Google search but there 
are specific symbols or words you can add to your search terms to make the re-
sults more precise.

Google Search usually ignores punctuation that isn’t part of a search operator. 
Specific operators that can be used are quotes, minus, plus, and asterisk, as fol-
lows:

To search for an exact match, put a word or phrase inside quotes. For example, 
“spermatocytic seminoma”.

To exclude words from your search, put a minus (-) in front of a word you want to 
leave out. For example, in a search for lymphomas, to eliminate images of Hod-
gkin lymphoma use: lymphoma -Hodgkin.

To search for wildcards or unknown words, put a * in your word or phrase where 
you want to leave a placeholder. For example, “largest * in the world”.

To combine searches, put “OR” between each search query. For example,  CK7 OR 
CK20 positive tumors. You can also add “AND” to give a narrower search that in-
cludes multiple terms.



9

https://images.google.comhttp://www.google.com

1. Initiate a Search
Enter the search term into the dialog box on the Google Images page 
(https://images.google.com), or just use Google’s default search page. If 
you use the default search page, you will have to then click on the Images 
link in the top menu bar, just beneath the search box.

this Google website 
displays only images

click on the Images button 
to view thumbnails after a 
search which starts at the 
Google default page 
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2. Filter the Images by Usage Rights
Click on the Search tools menu and then select the drop-down menu for 
Usage Rights. That menu offers five choices: 

•	 Not filtered by license
•	 Labeled for reuse with modification
•	 Labeled for reuse
•	 Labeled for non-commercial reuse with modification
•	 Labeled for non-commercial reuse

Select an option and the page refreshes to include only those images 
flagged with the associated usage rights. 

The images on the page are typically ones licensed by Creative Commons 
or GNU Free Documentation, or are items in the public domain. 

The Not filtered by license choice displays all the images. The Labeled for re-
use option allows you to use the image for commercial and non-commer-
cial purposes as specified in the license. The labeled for reuse with modifica-
tion option grants you the ability to alter the image (add annotations). 

For CERTLink purposes, the safest choice is to use images designated as 
Labeled for reuse with modification. This allows you to add text, arrows, or 
other annotations to the image.

click on the Tools button 
and then the Usage Rights 
menu to filter images
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3. Select an Image and Download It
Click on an image to enlarge it. You can see specific information about the image, 
such as its size, type (jpg, png, tif, gif, etc.) and where the image can be found on 
the web.

Click on the View Image button to enlarge the image even more. You can then 
drag it to your desktop to save it or you can also drag the enlarged image from 
the image detail page. Do not drag the thumb nail image because the resolution 
is too low.

Finally, click on the Visit button to go to the website that is hosting the image. 
Most of the images will be on the Wikimedia Commons site but some will be from 
Fickr or other image hosting website.

click on a thumbnail to 
enlarge the image

click on the image to go 
to the hosting website 
or use the Visit button

drag the image to your 
desktop to save it visit the web page to 

view the licensing rights
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4. Determine Image Rights and Attribution
Because you selected the image filter to show only images that can be used for 
both commercial and non-commercial use (labeled for reuse with modification), 
the web page displaying the image will usually indicate what the usage-rights 
are. In most cases, the images will have a Creative Commons license.

Other web pages may have a link to 
the license information.  It is import-
ant to review the specifics of the 
license so that you do not violate the 
intended use.

On the Creative Commons Wikime-
dia page, the specific image rights 
are in the Licensing section. 

Verify that the image is free to share 
and change (if you plan to add text 
or any other annotation). 

The image may require attribution. 
In that case, follow the guidelines 
shown. In most cases, that means 
indicating who provided the photo-
graph. 

When used for CERTLink, for exam-
ple, this information can be inserted 
after the reference. Here is an exam-
ple attribution for this seminoma 
image:

Image Copyright © 2011 Michael 
Bonert  / CC-BY-SA-3.0 / via WikiMedia 

or

Image Copyright © 2011 Michael 
Bonert (https://commons.wikimedia.
org/wiki/User:Nephron ). CC BY-SA 3.0 
(https://creativecommons.org/licens-
es/by-sa/3.0/legalcode ). 

The next page discusses image attri-
bution in more detail.
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5. Notes on Licensing
Wikimedia Commons only accepts free content—images and other media 
files that are not subject to copyright restrictions which would prevent them 
being used by anyone, anytime, for any purpose. 

Therefore, almost all of the content hosted on Wikimedia Commons may be 
freely reused subject to certain restrictions. You do not need to obtain a spe-
cific statement of permission from the licensor(s) of the content unless you 
wish to use the work under different terms than the license states.

Images under open content licenses may be reused without any need to 
contact the licensor(s), but just keep in mind that:

•	 some licenses require that the original creator (or pseudonym, if appli-
cable) be attributed

•	 some licenses require that the specific license be identified when reus-
ing (including, in some cases, stating or linking to the terms of the 
license)

•	 some licenses require that if you modify the work, your modifications 
must also be similarly freely licensed (i.e., you cannot be more restric-
tive than the original image)

The author may give specific verbiage for the attribution. If not, the simplied 
attribution shown below is acceptable:

Image Copyright © 2011 Michael Bonert  / CC-BY-SA-3.0 / via WikiMedia

The CC means Creative Commons licensure (version 3.0 in this case).
BY means give attribution. The SA means “share alike.”  This indicates that 
others can remix, tweak, and build upon the author’s work even for commer-
cial purposes, as long as they credit the author and license their new cre-
ations under the identical terms. 

The CC-BY-SA designation is the license used by Wikipedia / WikiMedia.

It is worth noting that content in the public domain may not have a strict 
legal requirement of attribution (depending on the jurisdiction of content 
reuse), but attribution is recommended to give correct provenance.

GNU Free Documentation 
logo

Creative Commons logo License type (CC-BY-SA)
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Part 3: Adjusting Images to ABPath Specifications 
and How to Take a Screenshot  and Save it as a JPEG
Introduction: Image Size and Resolution
In the previous sections, images were captured from a whole slide image or were 
downloaded from the web after an image search. These images may need to be 
adjusted to conform to the requirements of the ABPath item database vendor, 
Data Harbor.

Data Harbor requires that all images uploaded to the item database are in jpeg 
format and are no larger than 1500 x 1500 pixels. When downloading an image 
from the web, in general it is best to err on the side of using a large image so that 
as much detail as possible is preserved. 

Besides pixel dimensions, images also have resolution (pixels per inch). The usual 
resolution for web images is 72 ppi. Such images will look fine on a computer 
screen but will be jagged when printed on paper— closer to 300 ppi is needed 
for a crisp printed image. For ABPath purposes, 72 ppi is fine or slightly larger (120 
ppi).

For purposes of images used by the ABPath for items, an image size no great-
er than1500 x 1500 pixels and a resolution of at least 72 ppi is preferred. Note 
that higher resolutions images will take longer to load which may cause anxiety 
among our diplomates. 

Image types
Regarding image type, there are 5 main formats: tiff, jpeg, png, gif, and raw. Most 
web graphics are jpegs and png files. 

JPEG files are images that have been compressed to store a lot of information in a 
small-size file. A JPEG is compressed in a way that loses some of the image detail 
during the compression in order to make the file small (so called “lossy” compres-
sion). Each time an image is saved, a small amount of data is thrown away. Re-
peated compressions (saving a file multiple times) will degrade jpeg images. 

The png format is a “lossy” compression format but file sizes are larger than jpegs. 
The reason png files are used so widely on the web is that they can have transpar-
ency (no white background) and also they handle text much better than jpegs. 

Tiff images are lossless, so repeatedly saving the image does not result in any deg-
radation but the file size will be larger than either jpegs or png files. 

There are many software programs than can perform the functions of resizing and 
reformatting but two especially stand out because they are free and are part of a 
normal software installation: Microsoft’s Paint and Mac OS Preview. The following 
pages explain how to use these programs.
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1. Resize and Reformat the Image
Data Harbor requires images be in the jpeg format and no larger than 1500x1500 
pixels. The images you download from the web or screen capture from virtual 
images are quite variable in size and may need to be adjusted. Try to keep the im-
age size close to the maximum because smaller images will be blurry or pixelated 
when diplomates try to zoom in for a closer look.

You can see the image size when the cursor 
hovers over an image, as shown on the left. 

When selecting an image, give preference to 
larger image files. You can always down-size 
the image to 1500 x 1500 (see next page).

An easier method is to turn on 
an image-size tag for all the 
images on the web page. Do this 
by clicking on the Tools button 
and then select the Image size 
option from the drop down 
menu beneath Size.

when the cursor hovers 
over an image, a banner 
at the bottom shows the 
image size and sometimes 
the web location

click on the Tools button then 
select Show sizes from the 
More tools drop down menu

all of the images 
display their size 
in pixels
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2. Software to Resize and Reformat Images
There are several software programs you can use to change the file type and to 
resize images. 

On the Mac, the Preview programcomes already installed. Open the image and 
then select the Tools menu > Adjust size. Change dimension labels to pixels and 
type 1500 into the largest of the two numbers for height and width. Resolution 
can be 72 pixels per inch or higher. (72 ppi is a good resolution for images dis-
played on a computer screen. Higher resolutions are needed if you want to print 
the image). Be sure to check the Scale proportionally and Re-sample image boxes.

To convert images to a different file format (such as png to jpg), use the Export 
function in Preview or the Save as… function in Microsoft Paint. 

Here is a link to a page that discusses other free software programs than can 
change the image size and file type:

https://www.digitaltrends.com/computing/how-to-resize-an-image/

type in 1500 as the 
maximum pixel dimension

Mac OS Preview App

Microsoft Paint

On the Microsoft Windows platform, the Paint program comes al-
ready installed. In the toolbar, select the Home tab and then the 
Resize tool which is located just to the right of the Select option.
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3. How to Capture a Screenshot and Save it as a JPEG

Some questions may require capturing a set of cells from an Excel spreadsheet, a chart, or part of a 
PDF.  The following explains how to do a screen capture using the Windows 10 and the Macintosh OS. 

Windows 10

1.	 Open the Spreadsheet or PDF file from which you would like to make an image.
2.	 	 In the Windows search box type Snipping Tool and click the Snipping Tool option.
3.	 	 In the Snipping Tool Window, click the Mode option and select Rectangular Snip.
4.	 	 Draw a rectangle around the area; an image should open displaying the highlighted area.
5.	 	 Click File and Save As to save the image.
6.	 	 Adjust the image to conform to the ABPath optimum size (maximum of 1500 pixels). See page 15.

Open the Snipping Tool (you may need to search for it).
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Click the Mode option and select from the drop down menu. For cells in a spreadsheet, the  Rectangular 
Snip would be the best option. Otherwise, capture the entire window or the entire screen, as needed.

If you select the rectagular snip, draw a rectangle around the area you wish to capture. An image should 
open displaying the highlighted area.
	
Click File and Save As to save the selected region as an image. Adjust the size as needed (see page 15).



19

Macintosh OS

Screen captures on the Macintosh OS use a separate application which is accessed using command 
keys.  There are different steps depending on which version of the Mac OS you are using.  

Screenshot controls in macOS Mojave, Catalina or later operating systems are provided by the Screen-

shot app, which is in the Utilities folder of your Applications folder. Earlier operating systems such as El 
Capitan use the Grab app. 

By default, screenshots are saved with the name Screen Shot date and time.png.

You can open screenshot files with Preview or another app that can edit and view images. All these 
apps can export to a different format, such as JPEG, PDF, or TIFF. The ABPath requires all images to be in 
JPEG format.

Here are the steps applicable to all MacOS versions:

1.	 Open the Spreadsheet or PDF file from which you would like to make an image.
2.	 To capture the entire screen, press Command-Shift-3.  The screen shot will be automatically saved 

as a PNG file on your desktop.
3.	 To capture a window, press Command-Shift-4 and then the spacebar. The cursor changes to a cam-

era icon. Click on the window and the image will save to the desktop. By default, the image will 
have a shadow. To exclude the window’s shadow from the screenshot, press and hold the Option 
key while you click on the Window.

4.	 To capture a portion of the screen, press Command-Shift-4.  A crosshair cursor will appear, and you 
can click and drag an area you want to capture.  To move the entire selection, press and hold the 
Space bar while dragging.  Click on the escape key to cancel the capture. Release the mouse but-
ton and the screen shot will be automatically saved as a PNG file on your desktop. 

5.	 Double click on the image file to open it. In most cases, the file will open in Preview, which is the 
default application. 

6.	 Select File > Export. In the Export dialog box, choose JPEG as the file type and export to your pre-
ferred location (desktop, in side a folder, etc.). 

If you are using  Mojave and later, the above steps work but you can also press Shift-Command-5 to see 
the onscreen capture controls as shown below.

The icons allow you to capture the entire screen, the window (with its shadow), or a selected area. The 
other icons are for capturing video. 

capture window

capture entire desktop capture selected region

capture video of window or selected area
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